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This software can import other formats such as .dst, .pes and more, then will generate 
output of the embroidery system edit file (.qsd) and embroidery file (.zhs). The user 
interface can let users to operate through toolbar or pull down commands.
The system platform includes five major modules: Edit Mode, Text Manager, Monogram, 
Paint Mode,Photo Stitch.
This system provides digitization and editing capabilities, allowing you to freely create 
original embroidery designs.
You can combine embroidery patterns or apply knitting methods to pictures and text. 
You can use the various sewing types provided to design more embroidery patterns, and 
produce customized patterns for embroidery machines.

System Introduction
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Vector file:
The object drawn by the tools of "Drawing Module", including the outline and area of the 
satin, cache pattern, can change the color, stitch and stitch related parameters (stitch 
angle, stitch distance, thread distance .. etc.), can also edit the "line satin" path (by moving 
points, deleting points, adding points) to adjust the line satin shape.
Text file:
by inputting, deleting characters, editing text, specifying font and size.
Stitch file:
It is represented by a dashed frame. You can use the "Edit Point" function to move, delete, 
and add needle drop points, but you cannot change the stitching of the object outline and 
area.

	※ "Vector files" and "text files" can be converted into "stitch files" through the function of 
"Convert to Embroidery Objects".

Text file

Stitch file

Vector file

Edit text or change the fonts

Edit the stitch point to 
change the shape

Move, delete or add the 
point to change the line 
shape

File Introduction
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Artist Toolkit GUI And Tool Introduction
The main screen area of the program is as follows:

1. Title bar
Displays the icon, program and file's name.
2. Menu bar
All program functions can be selected from 
this menu bar.
3. Mode toolbar
Paint function to create, select, or edit 
patterns.
4. Ruler
5. Work area
6. Edit area
For users to edit design patterns and create 
embroidery stitches. The path used is the 
part that can actually be stored.
7. Toolbar
A quick cache for most used function tabs.
8. Close button
9. The Maximize button

10. The Minimize button
11. Embroidery setting
Customize embroidery parameters/color 
settings.

12. The status bar
Show the pattern size, zoom scale and 
coordinates of the current mouse cursor 
position.
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Open and Save File

	 New File
Path: [File]→<New File>
Description: The system can be restored to the default state when adding files.
Steps: Click on the menu [File] and click on <New File> from the dropdown menu.
Shortcut key: Ctrl+N (Windows system) / Command+N (OS system) 
​

	 Open File 
Path: [File]→<Open File...>
Description:
Open the system edit file (.qsd) when starting the embroidery design process.
Steps:
1.	 Click on the menu [File] and then click on <Open File...>
2.	 A window will pop-up and select the file where the file is stored.
3.	 Select the file and click to open the old file (Ctrl+O), or double-click the icon of the file.
Shortcut key: Ctrl+O (Windows system) / Command+O (OS system)

	 Save File 
Path: [File]→<Save File...>
Description: Save the edit file (.qsd) during the embroidery design process.
Steps: Click on the menu [File] and click on <Save File>
Shortcut key: Ctrl+S (Windows system) / Command+S (OS system)

	 Save File as
Path: [File]→<Save File as...>
Description:
Save the edit file (.qsd) during the embroidery design process or save as the actual format 
that the embrodery machine can read (*.qsd /*.zhs/*.exp).
Steps: Click on the menu [File] and click on <Save File as>

	● File
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	 Export Image
Path: [File]→<Export Image...>
Description: Export the design as a drawing file.
Steps:
Export all
Click on the menu [File] and click on <Export Image...>, then click on <Save> and set the 
storage path, and finally click on <Save>.

Export Image…

Save Close

Selective export
1.	 When there are multiple image files in the editing area, click the left mouse button to 

select the object to be saved, then click the menu [File] and select <Export Image File>.
2.	 At the bottom of the window, click the <Select Objects> or <All Objects> option, click 

<Save> to set the storage path, and finally click <Save>.

Export Image

Save Cancel
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 Print 

Path: [File]→<Print Preview>
Description:
Preview and print the content of the currently opened file. The pattern is placed in center. 
The preview printing function provides printing, zoom, one-page, two-page, four-page 
options and other options for users to use according to their needs. 
In addition to the pattern, the content display includes: file name, date, file name, 
embroidery pattern size, embroidery frame size, number of stitches, embroidery thread 
color, etc., for users to print for reference.
Steps:
Click the menu [File] and select <Print> and the preview print screen appears. Click 
<Print>, the print screen appears, select the printer, print range, number of copies and 
press the button to execute printing.
Shortcut key: Ctrl+P (Windows system) / Command+P (OS system)

	 Exit 
Path: [File]→<Exit>
Description: Shut down the system.
Steps: Click on the menu [File] and select <Exit>.
Shortcut key: Ctrl+F4 (Windows system) / Command+F4 (OS system)
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	● Save Embroidery File

	 Save File
Path: [File]→<Save File>
Description: Save the edit file (.qsd) during the embroidery design process.
Steps: Click on the menu [File] and click on <Save File> 
Shortcut key: Ctrl+S (Windows system) / Command+S (OS system)

	 Open embroidery library
Path: Toolbar <Open Embroidery library>
Description:
The built-in embroidery patterns in the software include categories such as flowers, plants, 
animals, trims, totems, sports, Christmas, Halloween, landscapes, household goods, etc., 
which can be imported and added to the current design page.
Steps:
Click on the toolbar [Open Embroidery library], a window will pop-out, click the desired 
embroidery image, and double-click the mouse twice.

Open embroidery library

Import and Open embroidery library
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	 Import Embroidery File
Path: Toolbar <Import Embroidery>
Description:
The supported embroidery file formats includes ZengHsing(.zhs/.zhx), Tajima(.dst), 
Brother(.pes/.pec), Bernina(.exp), Janome (.jef/.sew), Pfaff(.pcs/.Vp3), Singer(.xxx) and 
Husqvarna(.hus/.vip) can be imported and added to the current design page.
Steps:
Click on the toolbar [Import Embroidery], a window will pop-out, follow the path, and place 
the desired embroidery image. Drag the embroidery file to the window, you can also 
directly import the embroidery file.



11

	 Undo
Path: Toolbar <Undo>
Description:
The system saves the data changes in the editing process, and provides the user with the 
data content of the previous editing action.
Steps: Click the menu <Undo>.
Shortcut key: Ctrl+Z (Windows system) / Command+Z (OS system)

	 Redo
Path: Toolbar <Redo>
Description:
The system saves the data changes during the execution of the "Recover" function, and 
provides users with the action before the last "Recover".
Steps: Click on the menu <Redo>.
Shortcut key: Ctrl+Y (Windows system) / Command+Y (OS system)

	 Select
Path: Toolbar <Select>
Description: Select the object.
Steps:

1.	 The icon of the cursor will switch to .

2.	 Click the pattern you want to select, or drag the cursor across the pattern(s) you want 
to select. 
When dragging the cursor, all the patterns within in the selection area will be selected. 
Control points will appear around the selected pattern, and the status bar will display 
the pattern size (width and height).

Control Points

Status Bar

Common Functions
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3.	 Object movement can be combined with the "Ctrl" key to move vertically or horizontally, 
and you can also hold down the "Ctrl" key to add or remove objects.

4.	 To cancel the selected pattern, select a different pattern, click on a blank area of the 
design page or click any other button in the toolbar.

Shortcut key:
move objects vertically or horizontally, add or remove patterns. Ctrl (Windows system) / 
Command (OS system)

	 Pan
Path: Toolbar <Pan>
Description:
When designing an embroidery pattern, after the picture is zoomed to the required size, 
you can use "Pan" to move the pattern.
Steps:
1.	 The icon of the cursor will switch to .

2.	 Press and hold the left button of the mouse, the icon of the cursor will switch to , and 
then drag the mouse to move the pattern.

3.	 To cancel, click any other button in the toolbar.
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	 Edit Point
Path: <Edit Points>
Description:
The node of the object can be moved, deleted or added. (Including vector file, curve or 
stitch file)
Steps:
1.	 Click on the object you want to edit, and then click on <Edit Points> to display the object 

nodes.
2.	 Move the cursor over the node you want to change its position. When the shape of the 

cursor changes to , hold down the left mouse button and drag the node to the 
desired position.

3.	 To add a node to the object, move the cursor over the line segment where you want to 
add a node. When the shape of the cursor changes to , double-click the mouse to 
add a node.

4.	 To delete a node on the object, click on the node you want to delete and press "Delete" 
on the keyboard to delete, or click on the toolbar and click on <Delete> to delete the 
file.

	※ When the embroidery stitch file is in a group state, the editing and node functions 
cannot be used, and the editing and node functions can be performed only after the 
group is disbanded.



14

View Function

	● Zoom Tool

	 Zoom
Path: Toolbar <Zoom>
Description: Enlarge or reduce the display size of the work area on the screen.
Steps:
1.	 Click <Zoom> on the toolbar, and the cursor will appear . Press the left button of the 

mouse on the design panel to select the area you want to zoom in.
2.	 Click <Zoom> on the toolbar, and press the left button of the mouse, the cursor will 

appear . Each click will zoom in by 25%, up to 2000%.

3.	 Click the <Zoom> on the toolbar, and press the right mouse button, and the cursor will 
appear . Each click will zoom out by 25%, and the minimum zoom rate can be 25%.

Shortcut key:
Press the "Ctrl" button with the mouse wheel or the "Ctrl" button with the "+/-" button to 
zoom in/out the window. Ctrl (Windows system) / Command (OS system)

	 Zoom Original

Path: Toolbar <Zoom Original>
Description: Restore the display size of the work area on the screen.
Steps: Click on <Zoom Original> on the toolbar to restore the view size.
Shortcut key: Ctrl+0 (Windows system) / Command+0 (OS system)
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	 Cut
Path: Toolbar <Cut>
Description:
Remove the editing object (vector pattern or stitch pattern) selected, and temporarily store 
a copy of the data, which can be used to "paste" the data immediately.
Steps: After clicking the pattern you want to cut, select the toolbar and click <Cut>.
Shortcut key: Ctrl+X (Windows system) / Command+X (OS system)

	 Copy
Path: Toolbar <Copy>
Description:
Copy the object selected and will temporarily store a copy of the data, which can be used 
as an immediate data "paste" function.
Steps:
After clicking the pattern to be copied, select the toolbar and click <Copy> to copy a 
pattern.
Shortcut key: Ctrl+C (Windows system) / Command+C (OS system)

	 Paste
Path: Toolbar <Paste>
Description: "cut" or "copy" data copy into the system editing workspace.
Steps:
After performing the "cut" or "copy" action, click on the toolbar and click <Paste> to paste 
the pattern.
Shortcut key: Ctrl+V (Windows system) / Command+V (OS system)

	 Delete
Path: Toolbar <Delete>
Description: Delete the editing object selected.
Steps:
After click on the pattern to be deleted, click on <Delete> in the toolbar to delete the file.
Shortcut key: Delete (Windows system) / Function+delete (OS system)

Basic Edit Tools
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Environment Settings

	● Function Settings Introduction

	 Function Set

Path: Toolbar <Grid>
Description: Below will introduce how to set Grid, Language, Auto Save.

	 Grid

Path: Toolbar <Grid>
Description:
Set the grid size of the embroidery area, and show the grid in line or point type.
1.	 Show Grid: Line, Point

Function Settings

Function Settings

2.	 Grid Size (mm): 1~25 mm
3.	 Snap To Grid select whether to snap to the grid or not; if the snap function is turned on, 

the grid in lines or points will be automatically snapped to when creating an object or 
moving or scaling the object.

Steps:
Click the toolbar [Settings], select the grid tab, click <Grid>, and enter the grid size, check 
the grid lines or points, and check whether to align the grid lines.
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	 Language

Path: Toolbar <Settings>→<Option>→<Language>
Description: Set country language.
Steps:
Click the toolbar [Settings], select the option tab, click on menu, and select the desired 
language.

	 Auto Save

Path: Toolbar <Settings>→<Option>→<Auto Save>
Description:
The file will be automatically saved according to the customized time. When the computer 
is turned off or the software is forcibly closed, the file can be saved when the software is 
reopened.
Steps:
Click on the toolbar [Settings], select the option tab, tick on automatic storage and enter 
the value.

	※ 1(minimum)~1(default)~60(maximum), Unit: Minutes



Embroidery Setting



19

Path: <Stitch Effect>
Description:
It is divided into area sewing and contour sewing settings. When you click on the function 
icon (the background color of the icon is inverted), you can select the stitch method for the 
selected vector pattern object and set the secondary embroidery parameters, including 
angle, thread pitch, stitch length, staggered way...etc.

Function Icon: Turn off Function Icon: Turn on

Embroidery Stitches

	● Pattern Settings

	 Region Sew

	 Stitch Effect

Steps:
1.	 Click on the object.

2.	 The preset sewing area mode is . When the icon is clicked again, it will cancel 

the sewing area .
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Stitch Angle

Stitch Length

Stitch Gauge

Offset Angle

Pull Compensation

	 Complex Fill Stitch

0.20.2

Complex Fill Stitch

Stitches Preview

Zigzag Fill Type / Piping Fill Type

Stitches Preview

Complex Fill Stitch distinguish between the following two embroidery methods:

Piping Fill TypeZigzag Fill Type
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	※ The parameters below can be adjusted and set according to personal preference

Stitch Angle:

Change the direction of the stitching method, 45 (default), unit: degree.

Stitch Gauge:

The distance between two lines, 0.5 (default), unit: mm.

Stitch length

Stitch Gauge

Demonstration angle: 45° Demonstration angle:150°
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Pull Compensation:

Adjust the stitch expansion value of the selected area, which can be used to prevent the 
fabric from shrinking during embroidery and cause the embroidery pattern to be deformed. 
Range: 0, 0.2 (default), 0.35, 0.4, unit: mm.

Demonstration: 0mm Demonstration: 0.4mm

Stitch Length:

Adjust the distance between two stitches, 4.0 (default), unit: mm.

Stitch length

Offset Angle:

Adjust the offset of the parallel staggered needle position of the upper row and the lower 
row to produce different embroidering changes, 15 (default), unit: degree.

45° 90°
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	 Satin Fill Stitch

Satin Fill Stitch

Stitches Preview

Zigzag Fill Type / Piping Fill Type

Stitches Preview

Stitch Angle

Stitch Gauge

Pull Compensation

Satin Fill Stitch distinguish between the following two embroidery methods:

Piping Fill TypeZigzag Fill Type
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	※ The parameters below can be adjusted and set according to personal preference

Stitch Angle:

Change the direction of the stitching method, 45 (default), unit: degree.

Stitch Gauge:

The distance between two lines, 0.5 (default), unit: mm.

Stitch length

Stitch Gauge

Demonstration angle: 45° Demonstration angle: 150°
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Demonstration: 0mm

Pull Compensation:

Adjust the stitch expansion value of the selected area, which can be used to prevent the 
fabric from shrinking during embroidery and cause the embroidery pattern to be deformed. 
Range: 0, 0.2 (default), 0.35, 0.4, unit: mm.

Demonstration: 0.4mm
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	※ The parameters below can be adjusted and set according to personal preference

Cross-Stitch Size:

Set the size of the cross-stitch grid, 2.5 (default), unit: mm.

	 Cross Stitch

Cross Stitch

Stitches Preview

Cross-Stitch Size

Run Times

Demonstration: 2.5mm Demonstration: 5.0mm
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Run Times:

Set the run times of cross-stitch sewing, 2(default), unit: times.

Demonstration: 2 times Demonstration: 6 times
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	※ The parameters below can be adjusted and set according to personal preference

Stitch Angle:

Change the direction of the stitching method, 90 (default), unit: degree.

Demonstration angle: 90° Demonstration angle: 200°

	 Piping Stitch

Piping Stitch

Stitches Preview

Stitch Angle

Stitch Gauge

Stitch Length
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Stitch Gauge:

The distance between two lines, 2.0 (default), unit: mm.

Demonstration: 2.0mm Demonstration: 6.0mm

Stitch Length:

Adjust the distance between two stitches, 2.5 (default), unit: mm.

Demonstration: 2.5mm Demonstration: 6.0mm
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	 Underlay For Outline

Path: <Underlay>
Description:
It will underlay for outline.

	※ The stitches used in some areas can be used with the bottoming function. If there are 
any function options on the screen, please refer to the following instructions.

	 Underlay

Outline / Zigzag / Piping

Outline and Zigzag /Outline and Piping /
Outline and Piping cross

Middle Line

Underlay Gauge



31

	 Underlay For Zigzag

Path: <Underlay>
Description:
It will underlay for zigzag (width adjustable)
1.	 When complex fill stitch, stitches will underlay vertically
2.	 When satin fill stitch, stitches will underlay horizontally

Underlay Gauge:

The distance between two lines, 2.5 (default), unit: mm.

Demonstration: 2.5mm Demonstration: 10mm
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	 Underlay For Piping

Path: <Underlay>
Description:
It will underlay vertically for piping.

Underlay Gauge:

The distance between two lines, 1.5 (default), unit: mm.

Demonstration: 1.5mm Demonstration: 10mm
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	 Underlay For Outline and Zigzag

Path: <Underlay>
Description:
It will underlay for outline and zigzag (width adjustable).
1.	 When complex fill stitch, stitches will underlay vertically.
2.	 When satin fill stitch, stitches will underlay horizontally.

Underlay Gauge:

The distance between two lines, 2.5 (default), unit: mm.

Demonstration: 2.5mm Demonstration: 10mm
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	 Underlay For Outline and Piping

Path: <Underlay>
Description:
It will underlay for outline first and for piping vertically.

Underlay Gauge:

The distance between two lines, 1.5 (default), unit: mm.

Demonstration: 1.5mm Demonstration: 10mm
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	 Underlay For Outline and Piping cross

Path: <Underlay>
Description:
It will underlay for outline first and then zigzag and piping stitches in 45° and 135°.

Underlay Gauge:

The distance between two lines, 2.0 (default), unit: mm.

Demonstration: 2.0mm Demonstration: 10mm
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	 Underlay For Middle Line

Path: <Underlay>
Description:
It will underlay for middle line two to three times.
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	 Line Sew

Steps:
1.	 Click on the object.

2.	 The preset contour sewing icon mode is . When the icon is clicked again
, it will cancel contour sewing.

	 Single Outline

The number of round trips for two stitches is once

Single Outline

Stitch Length

Stitches Preview
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	※ The parameters below can be adjusted and set according to personal preference

Stitch Length:

Adjust the distance between two stitches, 2.0 (default), unit: mm.

	 Triple Outline

The number of round trips for two stitches is three times.

Triple Outline

Stitch Length

Stitches Preview

1

2

3

	※ The parameters below can be adjusted and set according to personal preference

Demonstration: 2.0mm Demonstration: 10mm
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Stitch Length:

Adjust the distance between two stitches, 2.0 (default), unit: mm.

	 Satin Stitch

Gauge

Width

Satin Stitch

Stitch Gauge

Stitches Preview

Stitch Width

	※ The parameters below can be adjusted and set according to personal preference

Demonstration: 10mmDemonstration: 2.0mm
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Stitch Gauge:

The distance between two lines, 1.0 (default), unit: mm.

Demonstration: 1.0mm Demonstration: 10mm

Stitch Width:

Stitch Width, 3.0 (default), unit: mm.

Demonstration: 3.0mm Demonstration: 10mm
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	 Stem stitch

Stem Stitch

Stitches Preview

Stitch Angle

Stitch Width

Stitch Gauge

Single Stem / Double Stem

Stem stitch distinguish between the following two embroidery methods:

Double StemSingle Stem

	※ The parameters below can be adjusted and set according to personal preference

Stitch Gauge:

The distance between two lines, 1.5 (default), unit: mm.

Demonstration: 4.5mmDemonstration: 1.5mm
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Stitch Width:

Stitch Width, 2.0 (default), unit: mm.

Demonstration: 2.0mm Demonstration: 3mm

Stitch Angle:

Change the direction of the stitching method, 45 (default), unit: degree.

Demonstration angle: 45° Demonstration angle: 100°
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	 Chain Stitch

Chain Stitch

Stitches Preview

Number Of Times

Size

Left Arrangement / Right Arrangement

Triangle / Rhombus

Chain Stitch distinguish between the following two embroidery methods:

RhombusTriangle

Arrangement: 
Left arrangement - start on the left and end on the right
Right arrangement- start on the right and end on the left

Right ArrangementLeft Arrangement
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	※ The parameters below can be adjusted and set according to personal preference

Size:

Size, 4.0 (default), unit: mm.

Demonstration: 5.0mmDemonstration: 4.0mm

Number Of Times:

Number of times, 5 (default), unit: times.
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Motif stitch distinguish between the following six arrangement setting:
Horizontal arrangement(default): The Motif pattern embroidery are arranged upward along 
the horizontal axis.

	 Motif stitch

Spacing

Pattern Size

Run Pitch

Motif Stitch

Stitches Preview

Arrangement Setting

Motif Folder
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Horizontal mirror：Arrange the Motif pattern embroidery downward along the horizontal 
axis.

Horizontal stagger：The Motif pattern embroidery are arranged one up and one down 
along the horizontal axis
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Vertical arrangement(default)：The Motif pattern embroidery are arranged to the right 
along the vertical axis.

Vertical mirror：Arrange the Motif pattern embroidery to the left along the vertical axis.

Vertical stagger：The Motif pattern embroidery are arranged alternately on the right and 
left along the vertical axis
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Motif Folder:

Pattern embroidery pattern list.

	※ The parameters below can be adjusted and set according to personal preference
Pattern size: Set the height size, width size, unit: mm.

Width

Height
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	※ The following parameters can be used to adjust the number of needle points according 
to personal preference.

Run Pitch Setting:

Stitch length judgment value setting for pattern embroidery, 5.0mm (default), unit: mm
Set the stitch distance for a pattern embroidery to 2.0mm. If the stitch distance in a single 
pattern is greater than 2.0mm, the needle drop point will increase.

1.4mm 3.0mm

Not exceeding the stitch distance setting of 
2.0mm, will not increase needle points

Exceeding the stitch distance setting of 
2.0mm, will increase needle points (see in 
the arrow)

Spacing:

Setting the length between Motif pattern, 0.0 (default), unit: mm.

Demonstration: 3.0mmDemonstration: 0.0mm
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	● Text stitches setting

	 Stitch Effect
Path: <Stitch Effect>
Description:
It is divided into area sewing and contour sewing setting. When the function icon is 
pressed, the stitch selection can be made for the selected vector pattern object, and the 
embroidery parameters can be set, including angle, thread pitch, stitch length, Staggered 
way... etc.

	 Region Sew

Steps:
1.	 Click on the object.

2.	 The preset sewing area mode is . When the icon is clicked again , it will 
cancel the sewing area.

3.	 After clicking the contour sewing icon, the parameters below can be adjusted and set 
according to personal preference.

Stitch Gauge

Zigzag Fill Type / Piping Fill Type

Stitches Preview
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	※ Stitch Gauge:

The distance between two lines, 0.5 (default), unit: mm.

Demonstration Stitch Gauge: 
0.5mm

Demonstration Stitch Gauge: 
1.0mm



52

	 Underlay

Path: <Underlay>
Description:
It will underlay for outline.

	 Underlay for outline

Path: <Underlay>
Description:
It will underlay for zigzag (width adjustable).

	※ Stitch Gauge: 3.0 (default), unit: mm.

	 Underlay for zigzag
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	 Underlay for outline and zigzag
Path: <Underlay>
Description:
It will underlay for outline and zigzag (width adjustable).
1.	 When complex fill stitch, stitches will underlay vertically.
2.	 When satin fill stitch, stitches will underlay horizontally.

	※ Underlay for zigzag
Stitch Gauge: 3.0 (default), unit: mm.

Path: <Underlay>
Description:
It will underlay for middle line two to three times.

	 Underlay for middle line
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	 Line Sew

Steps:
1.	 Click on the object.

2.	 The preset of the contour sewing is in inactive status . When the icon is clicked 

will appear , clicked again will cancel contour sewing.

3.	 After clicking the contour sewing icon, the parameters below can be adjusted and set 
according to personal preference.

Single outline

Run pitch

Run times
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	※ Run Pitch:
Adjust the distance between two stitches, 0.5 (preset), unit: mm.

Demonstration Run Pitch: 0.5mm Demonstration Run Pitch: 3.0mm

	※ Run times:

The number of embroidery of the outer frame line, you can choose 1, 3, 5 times.

Demonstration run times: 1 times Demonstration run times: 3 times Demonstration run times: 5 times
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	 Convert To Embroidery Object 

Path: <Convert To Embroidery Object >
Description:
Convert vector object into stitch object and after converted, the stitch object will have 
dotted line to differentiate.
Steps:
Click the objects you want to convert, and click <Convert To Embroidery Object> from the 
menu.

	※ In Text Manager, Monogram mode, Paint mode, the files are generated in vector format.

Vector Object Embroidery Object
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Embroidery Preview and Setting

	 Thread Table
Path: <Thread Table>
Description:
The user can change the selected thread color brand and change the embroidery color; for 
the selected object, click the left mouse button to fill the color in the area, and click the right 
mouse button to fill the outline color. The area and color will appear on the color wheel 
from the outline of the butterfly symbol.

	※ On the stitch file, click the left mouse button or the right button to fill in color directly and 
the butterfly symbol of the area and outline will appear on the color wheel at the same 
time.



58

Objects drawn using the "Drawing Module" tool, including line satin, cache patterns, etc., 
will be automatically brought the default color (area-gray/line-dark gray), when the color of 
the area and outline on the color wheel is reset, the object drawn again will produce color 
with the reset color.

Default Color Reset Color New Object With The Reset Color

The text objects drawn by the tools of "Text Module" and "Combined Character Module", 
the default color is dark gray color. After the text color is reset, the new text design will 
continue to maintain the default color dark gray.

Default Color Reset Color New Object With The Reset Color
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The selected single object will bring out the color information used by the object in the 
color wheel information. If multiple objects or group objects are selected, the used color 
information will not be brought out.

Single Object

Multiple Objects
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	 Select Thread Color
Path: <Select Thread Color>
Description:
Sort according to the color of each block, add and modify colors according to the thread 
colors of each brand.
Steps:
1.	 Click <Select Thread Color>
2.	 In the dialog box, select the section you wish to change and import the selected thread 

color manufacturer's designated color, or you can directly enter the thread color number 
or color name in the color number box to specify the desired color.

	※ After selecting the color in the thread list, you can use the left mouse button on the top 
of the color to quickly click twice to quickly import the color.

 Select Thread Color

Select Thread Color

Color Information

	● Select Thread Color
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	 Set User's Thread Color
Path: <Set User's Thread Color>
Description:
Can create own labels for frequently used thread colors,  add and modify colors.
Steps:
1.	 Click <Set User's Thread Color>, a window (Set User's Thread Color) appears, click 

<Add New Users Thread Brand>, a window (New User Brand) appears, enter the name 
according to personal needs, and finally click to create .

2.	 Customize the name of the brand: select the thread color required by each brand, 
import it into the custom brand, and also edit and change the name, thread name, 
thread color number or delete it, and add customization R, G, B numerical value color 
or adjust the R, G, B numerical value to set the desired color.

User Brand List:

Set User's Thread Color

Thread Brand List: 

Add New Users Thread Brand
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	 Set Embroidery Sequence
Path: <Set Embroidery Sequence>
Description:
Set the embroidery order of each stitch object, and display continuous blocks of the same 
color in the same color group.
Steps:
1.	 Click <Set Embroidery Sequence> and a window (Set Embroidery Sequence) will 

appear.
2.	 To enlarge the pattern to make it clearer, check <Enlarge> to fill the frame with stitch 

objects.
3.	 To change the sewing order of a color, select the color frame you want to move, and 

then drag the frame to the target position or use the left and right buttons to adjust.

Set Embroidery Sequence

	 Run Stitches
Path: <Run Stitches>
Description:
Stitch simulator function On/Off.
For the selected one or more embroidery patterns that have generated stitch paths, 
perform stitch embroidery simulator on the computer screen.
Steps: Click <Run Stitches> directly from the toolbar.
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2 3 4 6

7 8 9

11 10

Run Stitches

1.	 Embroidery position: The slider shows the current progress of the simulator, and you 
can also move the slider to change the simulator progress.

2.	 Rewind: start stitch simulator and simulate stitch forward.
3.	 Play: start stitch simulator, and simulate stitches in backward.
4.	 Pause: When the stitch simulator is on forward or backward, press this key to pause.
5.	 Stop: stop the simulator, and the simulator position will return to the first stitch at the 

beginning.
6.	 Speed: drag the slider to adjust the stitch speed.
7.	 Display the current number of stitches / Total number of stitches.
8.	 Previous stitch: One stitch forward. 

Next stitch: One stitch backward.
9.	 Thread color layer: Current thread color / Number of all thread colors.
10.	Previous thread: return to the beginning of the previous thread color stitch. 

Next thread: return to the beginning of the next thread color stitch.
11.	Current stitch number: Can input specified stitch numbers. 

Shortcut key (Stitch simulator) : 
1.	 "ESC key" is the exit mode. ESC (Windows system)/ ESC (OS system)
2.	 "+" to the next stitch, press "-" to go back to the previous stitch.

"+/-"(Windows system) / " ⇧ +/-"(OS system)
3.	 Press the "Ctrl" button with the mouse wheel or the "Ctrl" button with the "+/-" button to 

zoom in/out the window. Ctrl (Windows system) / Command (OS system)
4.	 It can be used with the blank key to pan the screen.
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	 Show/Hidden Needle Point
Path: <Show/Hidden Needle Point>
Description: To display each needle point in embroidering.
Steps:
Directly click <Show/Hidden Needle Point> from the toolbar to show or hide the needle 
point.

	 3D Simulate
Path: <3D Simulate>
Description: The stitch lines are displayed in 3D simulation mode.
Steps:
Directly click on <3D Simulate> from the toolbar to preview the finished product.
Shortcut key:
In 3D simulation, press "ESC" to exit mode. ESC (Windows system) / ESC (OS system)
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	 Show / Hidden Grid

Path: <Show/Hidden Grid>
Description: Toggle On/Off the display of the grid.
Steps:
Directly click <Show/Hidden Grid> from the toolbar to show or hide the grid (Grid).

	 Show / Hidden Axis

Path: <Show / Hidden Axis>
Description: Show/hide the center mark line (Axis).
Steps:
Directly click <Show / Hidden Axis> from the toolbar to show or hide the center mark line.

	 Show/Hidden Hoop

Path: <Show / Hidden Hoop>
Description: Toggle On/Off the display of the hoop frame on screen.
Steps: 
Directly click on <Show / Hidden Hoop> from the toolbar to show or hide the embroidery 
frame.

Change Hoop Size
Description:
Provide embroidery hoops of different sizes for users to choose. The 
default hoop size is 100*100mm.
There are six kinds of embroidery hoop sizes: Hoop- 40×40mm, Hoop 
50×70mm, Hoop-100×100mm, Hoop-110×170mm, Hoop-120×180mm, 
Hoop-160×260mm.
Steps: Click on the menu toolbar and select the appropriate embroidery 
hoop size.

Work Area Settings
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	 Fabric
Path: <Fabric>
Description: Choose the fabric material and color you want to match.
Steps:
Directly click on <Fabric> from the toolbar, select the fabric and color, and the background 
color in the editing area will be switched to the selected fabric and color. Press OK to 
return to the main screen, and the selected color will be displayed in the editing area. The 
texture of the cloth will be presented in the 3D simulation function mode.

Fabric Setting

	 Instruction Manual
Path: <Instruction Manual>
Description: To view the digital version of Instruction Manual.
Steps :
1.	 Click <Instruction Manual> from the menu.
2.	 To view the instruction manual in PDF format with Adobe® Reader®.
3.	 If your computer doesn't have Adobe® Reader® software, download and install it from 

Adobe Systems Incorporated website (http://www.adobe.com.tw/).
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Account Functions

	 Account Functions
Path: <Account Functions>
Description: Account functions
Steps: 
1.	 After first installation, register the user account and password to log in or close the 

window to skip this step.

Register

Sign in

Create an account Login

	※ APP account can also log in into "Artist Toolkit" embroidery software, no need to 
register new account. 

	※ During account registration, you will receive an authentication through your mailbo.

2.	 The created account can be deleted, log out of account, change password and manage 
personal information.
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	 Upload Embroidery File To Cloud
Path: <Upload Embroidery File To Cloud>
Description: File transfer to cloud
Steps:
Click on <Upload Embroidery File To Cloud> ; the file will be transferred to the cloud, 
and a successful message will appear.

	※ After logging in to the account, there must be an image file in the file before the file can 
be sent to the cloud.

	※ Only one file can be placed in the cloud space and repeating upload files will overwrite 
the old file.

Information

Embroidery file is uploaded.
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	 Tutorial
Path: <Tutorial>
Description: To view the tutorial videos online.
Steps: Click <Tutorial> from the menu.

	 About
Path: <About>
Description:
Check the copyright information and the version of software your device is running.
Steps: Click <About> from the menu.

About

Online Tutorial and Software Version



70

	 Check Update
Path: <Check Update>
Description: Check on the software updates.
Steps: 
1.	 Click <Software Update> from the menu. The software will determine the update 

automatically.
2.	 If the latest version is available to upgrade, the software will show the message:

Click <Yes> to download and upgrade the software, after the update is complete, it will 
restart the software.
Click <No> to skip the upgrade and enter the software.

Question

Updating

Cancel

Update the software?

Check Update



71

	 Information
Path: <Information>
Description:
To view the current information of the embroidery design file which includes the file name, 
size, number of stitches, number of colors and color sequence.
Steps: Click <Information> from the menu.

Information



Mode Functions
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Edit Mode

	● View The Patterns In The Preview All Window

	 Preview All
Path: <Preview All>
Description: View the overall layout of the workspace.
Steps: Click <Preview All> from the menu.
Shortcut key:
Preview all screen mode, press "ESC" to exit.
( "ESC" in Windows and OS systems).

	 Normal / Full Screen
Path: <Normal / Full Screen>
Description: Display the program in a full screen.
Steps: Click <Full Screen> from the menu.
Shortcut key: 
Press "F11" to display in a full screen, press "ESC" or "F11" to exit.
( "ESC/F11"  in Windows systems).

	 Zoom Object
Path: <Zoom Object>
Description:
Zoom in and view the selected object in the maximum level within the workspace.
Steps:
Click the pattern you want to view, and click <Zoom Object> from the menu. The selected 
object will be displayed in maximum level in the work area.
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	 Zoom Hoop
Path: <Zoom Hoop>
Description:
Zoom in and view the selected hoop in the maximum level within the workspace.
Steps:
Click <Zoom Hoop> from the menu to display in maximum level in the work area.

	● Edit Tools

	 Select All
Path: <Select All>
Description: Select all the objects in the workspace.
Steps: Click <Select All> from the menu.
Shortcut key: Ctrl+A(Windows system) / Command+A(OS system)

	 Measure
Path: <Measure>
Description: Measure the actual length of the workspace.
Steps:
Click <Measure> from the menu.  The mouse will show "+", press and drag the mouse 
cursor in the workspace. The measurement results will be displayed in the program.
Shortcut key: Ctrl+M(Windows system) / Command+M(OS system)
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	● Group Objects

	 Group Objects
Path: <Group>
Description:
Select multiple objects and group them together as a single unit to edit and design.
Steps: Select the objects you want to group, and click <Group> from the menu.
Shortcut key: Ctrl+G(Windows system) / Command+G(OS system)

	※ The group function is an one time function. If you want to group multiple group objects, 
please disengage the grouped objects first and then group all objects again at once.
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	 Ungroup Object
Path: <Ungroup Object>
Description: Select the group you want to disengage and restore it to separate objects. 
Steps: Click the objects you want to ungroup, and click <Ungroup Object> from the menu.
Shortcut key: Ctrl+U(Windows system) / Command+U(OS system)
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	● Edit Size

	 Lock Proportion
Path: <Edit Size>
Description: 
Edit the size of the selected object and set the aspect ratio to fixed or not.
Steps: 
1.	 Click the object you want to edit, and click <Edit Size> from the menu.
2.	 Select the "Aspect ratio" ON/OFF (a), when it's set as ON (the pattern is highlighted 

grey  ), the original aspect ratio will be maintained.

3.	 To adjust the object to a specific size, click the size option (b) and entering a value in 
the Width or the Height box to adjust the size.

4.	 To adjust the object size to a specific percentage, click the percentage option (c) and 
entering a value in the Width or the Height box to resize it.

a b c

Fixed Aspect Ratio Without Fixed Aspect Ratio
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	 Rotate
Path: <Rotate>
Description: Edit the rotation angle of the selected object.
Steps: 
Click the object you want to edit the rotation angle, and enter the angle value from 0~359 
in the field.

Rotate object manually
Steps: 
1.	 Click the object you want to edit.
2.	 Move the cursor to the pink control point above the center of the selected object. When 

the icon of the cursor is switched to , press and hold the left mouse button to 
rotate it.
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	● Horizontal Or Vertical Flip Objects

	 Flip Horizontal
Path: <Flip Horizontal>
Description: To flip the selected object horizontally.
Steps: 
Click the object you want to flip horizontally, and click <Flip Horizontally> from the menu.

	 Flip Vertical
Path: <Flip Vertical>
Description: To flip the selected object vertically.
Steps: 
Click the object you want to flip vertically, and click <Flip Vertical> from the menu.
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	● Align

	 Align Left
Path: <Align Left>
Description:
When 2 or more objects are selected and using this feature, all objects will be left aligned 
to the leftmost object.
Steps: 
Click <Align Left> from the menu.
Shortcut key: 
Press "Ctrl" key with the mouse to click on selecting objects, it can select multiple or 
reduce objects.
Ctrl key (for Windows) / Command key (for Mac OS)

	 Align Middle
Path: <Align Middle>
Description:
When 2 or more objects are selected and using this feature, all objects are aligned to the 
one on in the vertical center.
Steps: 
Click <Align Middle> from the menu.
Shortcut key:
Press "Ctrl" key with the mouse to click on selecting objects, it can select multiple or 
reduce objects.
Ctrl key (for Windows) / Command key (for Mac OS)
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	 Align Right
Path: <Align Right>
Description:
When 2 or more objects are selected and using this feature, all objects are aligned to the 
one on the far right.
Steps: 
Click <Align Right> from the menu.
Shortcut key:
Press "Ctrl" key with the mouse to click on selecting objects, it can select multiple or 
reduce objects.
Ctrl key (for Windows) / Command key (for Mac OS)

	 Align Top
Path: <Align Top>
Description:
When 2 or more objects are selected and using this feature, all objects are aligned to the 
one on the topside.
Steps: 
Click <Align Top> from the menu.
Shortcut key: 
Press "Ctrl" key with the mouse to click on selecting objects, it can select multiple or 
reduce objects.
Ctrl key (for Windows) / Command key (for Mac OS)
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	 Align Center
Path: <Align Center>
Description:
When using "Select All" function or drag-select multiple objects, all objects are aligned to 
the one on in the horizontal center.
Steps: 
Click <Align Center> from the menu.
Shortcut key:
Press "Ctrl" key with the mouse to click on selecting objects, it can select multiple or 
reduce objects.
Ctrl key (for Windows) / Command key (for Mac OS)

	 Align Bottom
Path: <Align Bottom>
Description:
When 2 or more objects are selected and using this feature, all objects are aligned to the 
one on the downmost.
Steps: 
Click <Align Bottom> from the menu.
Shortcut key:
Press "Ctrl" key with the mouse to click on selecting objects, it can select multiple or 
reduce objects.
Ctrl key (for Windows) / Command key (for Mac OS)
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	 Align Hoop Center
Path: <Align Hoop Center>
Description:
When objects are selected and using this feature, all objects are aligned to the hoop 
center.
Steps: 
Click <Align Hoop Center> from the menu.
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	● Array

	 Copy Object To Top
Path: <Copy object to top>
Description:
Click the object and use <Copy the objects spacing> and <Copy the objects number of 
times> to duplicate the objects to the upper position.
Steps: 
Click <Copy object to top> from the menu.
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	 Copy Object To Bottom
Path: <Copy object to bottom>
Description:
Click the object and use <Copy the objects spacing> and <Copy the objects number of 
times> to duplicate the objects to the bottom position.
Steps: 
Click <Copy object to bottom> from the menu.
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	 Copy Object To Left
Path: <Copy object to left>
Description:
Click the object and use <Copy the objects spacing> and <Copy the objects number of 
times> to duplicate the objects to the left side position.
Steps: 
Click <Copy object to left> from the menu.

	 Copy Object To Right
Path: <Copy object to right>
Description:
Click the object and use <Copy the objects spacing> and <Copy the objects number of 
times> to duplicate the objects to the right side position.
Steps: 
Click <Copy object to right> from the menu.
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	 Copy Object To Four Directions
Path: <Copy object to four directions>
Description:
Click the object and use <Copy the objects spacing> and <Copy the objects number of 
times> to duplicate the objects to the four direction positions.
Steps: 
Click <Copy object to four directions> from the menu.
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	 Copy With Flip
Path: <Copy with flip>
Description:
Click the object you want to copy and use <Copy with flip> to flip the duplicate object 
vertical or horizontal. (Choose the flip function, the button background color will be marked 
in grey .)

Steps: 
Click <Copy with flip> from the menu.
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Text Manager

	● Edit Text

	 Text Tool
Path: <Text Tool>
Description:
The text tool has 11 built-in fonts, and the text can enter by using the text icon on the sub-
screen or use the keyboard to enter the text directly.
In addition to set the text spacing, it also can change the font size (the defaulted font size 
is 10mm). The drop-down menu provides 5 font sizes. When the text is inserted into the 
editing screen, you can use the size adjustment function or use the mouse to adjust the 
size arbitrarily.
Steps: 
1.	 Click <Text Tool> from the menu, the mouse cursor will change to .

2.	 Click on the working area where you want to enter the text.
3.	 In the pop-up screen, it will show all characters of this font, you can select the text 

direction, fonts, enter the text, select the font size, and set the text spacing in 
sequence.

Input Text

Text Align Horizontal.

Text Align Vertical: The available align type are Left, Center, Right.

Select Size: The available size are 10, 20, 30, 40, 50mm.

Select Character: 11 built-in fonts.
Spacing: -10(minimum)~0.0(default)~+30.0(maximum), unit: mm.
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4.	 Click , the text you have designed will display in the working area.

	※ To edit the generated text again, you can double-click the left button of the mouse and 
the editing box will appear or click the <Text Tool> on the menu to use the font size 
selector, or use the mouse to adjust the font size.
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	● Text Align Path

	 Text Align Path
Path: <Text Align Path>
Description: 
Use the generated text and drawn lines or cached graphics to align the text path. You can 
edit the line shape, or change the font, edit content, size, and spacing.
Steps: 
1.	 Select the text and line or cache graphics.
2.	 Click <Text Align Path> on the menu, and the text will align the path.

3.	 Text path align type.
Horizontal type:
Align Left , Align Middle , Align Right , Distribute Horizontally .
Vertical type:
Align Bottom , Align Center , Align Top .

Flip Vertical: To turn an object upside-down following the path.

Fixed text direction: text angle will not adjust following the path.
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4.	 To separate the text and line, can choose <Horizontal Text> or <Vertical Text>
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Monogram

	● Monogram

	 Monogram Text Tool
Path: <Monogram Text Tool>
Description:
Monogram embroidery alphabets (including 26 uppercase alphabets), 3, 2 and 1 Letter 
monogram, 5 style of monogram fonts, and with variety of decorative frames can be 
selected.
Steps: 
1.	 Click <Monogram Text Tool> on the menu, the mouse cursor will switch to .

2.	 <Monogram> contains alphabets, font styles, 3, 2 and 1 Letter monogram. Enter 
the alphabets by keyboard or click from the pop-up screen, can choose design with 
decorative frames or not. The designed monogram will appear in the preview screen.

Monogram Setting

Text Font: 5 style of monogram fonts.

Character number: 3, 2 and 1 Letter monogram.

Select Frame: The frames will be varied based on the fonts.

Text: Including 26 uppercase alphabets.
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3.	 Click on  the editing area, and designed monogram will display on it.
If you want to modify the design, select the monogram, double click the left mouse 
button quickly or click <Monogram Text Tool> on the menu, the editing box will appear.

Impostazione monogramma
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Paint Mode

	● Paint Function

	 Draw Polyline

Path: <Draw Polyline>
Description:
Draw a series of continuous line segment. You can click the right mouse button to return 
to the last position ; to end the drawing, double click the left mouse button to finish the 
drawing.
Steps: Click <Draw Polyline> on the menu.
Shortcut key:
Draw a line with "Ctrl" key to draw vertically or horizontally. 
Ctrl (Windows system) / Command (OS system)

	 Draw Curve

Path: <Draw Curve>
Description:
Draw a continuous curve. You can click the right mouse button to return to the last position; 
to end the drawing, double click the left mouse button to finish the drawing.
Steps: Click <Draw Curve> on the menu.

	 Draw Arc
Path: <Draw Arc>
Description:
To create an arc, click on the workplace to set the start point. Then decide the arc's length 
and click to set the end point of the arc. Move the mouse cursor until the desired arc shape 
and size is previewed, and then click to set the arc.
Steps: Click <Draw Arc> on the menu.

1 2

3
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Paint Mode
Path: <Paint Mode>
Description:
It can draw 12 shapes by the graphic tool, such as heart, star or polygonal.
Steps:
Click <Paint Mode> on the menu and select the desired pattern. Click on workplace and 
drag the mouse cursor to create the graphic. 

Draw Rectangle Draw Rhombus

Draw Ellipse Draw Shield-1

Draw Octagon Draw Shield-2

Draw Triangle Draw Pentagon

Draw Star Draw Dart

Draw Heart Draw Water
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	 Open curve
Path: <Open Curve>
Description:
Use graphics tablets or mouse to draw an open curve.
Steps:
Click <Open Curve> to draw an open curve. Each curve is a sigle object which can be 
edited individually.

	 Closed curve
Path: <Closed Curve>
Description:
Use graphics tablets or mouse to draw a closed curve.
Steps:
Click <Closed Curve> to draw a closed curve. When the start point and end point are 
close, release the mouse button to finish drawing closed curve(photo 1). 
When click <Closed Curve>, it can also connect two points and the saperated lines will be 
combined into one.(photo 2-4)

Photo 1 Photo 2 Photo 3 Photo 4
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	 Pressure sensitivity
Path: <Pressure Sensitivity>
Description:
Control your stroke with the force of your hand.(Recommend to use graphics tablets for 
better performance)
Steps:
Click<Pressure Sensitivity> and start to draw.
1.	 Drawing by tablets: control your stroke with the force of your hand.
2.	 Drawing by mouse: width is set by default.

	※ Stitch Gauge: 1.0 (default), unit: mm.

The effect of Drawing 
by tablets

The effect of Drawing 
by mouse
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	 Applique
Path: <Applique>
Description:
Applique Assistant
Draw a shape by the graphic tool and create an applique pattern by Applique Assistant.

	※ Remark: After created the pattern, it will be stitch object and shows around the object in 
dotted line.

Steps:
Click <Applique> for Applique Assistant.
1.	 Applique materials: Specify cutting lines for the applique.
2.	 Applique Position: 

Option 1: Specify cutting lines for the applique and cut the shape, and attach the 
appliqué piece.

Option 2: Sew the outline of the applique as running stitches and cut out.
3.	 Tack down: Select one of stitches from Satin stitch/E stitch/V stitch. The appliqué piece 

can be basted onto the base fabric. 

Satin stitch

Width Stroke height Stroke height

Gauge Stitch length Stitch length

E stitch V stitch

2 3 54 ba

Applique Assistant

1



100

4.	 Covering and select one of stitches from Satin stitch/E stitch/V stitch. Tack down will be 
cancelled when seleting E stitch or V stitch.

	※ Satin stitch: width 2.0(min)-3.0(default)-10(max) mm
gauge0.2(min)-0.5(default)-10(max) mm

	※ E stitch: stitch length 2.0(min)-3.0(default)-10(max) mm
stroke height 1.0(min)-2.0(default)-10(max) mm

	※ V stitch: stitch length 2.0(min)-3.0(default)-10(max) mm
stroke height 1.0(min)-2.0(default)-10(max) mm

Satin stitch E stitch V stitch

5.	 Set the material: selecting built in material or load a image, it can simulate and preview.
a. There are 21 built in materials and 25 colors.
b. Please load desired image. Support format: *.jpg *.png *.gif *.bmp *.tif *.tiff

The simulation to applied the fabrics
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	● Photo Stitch-Sub module 1

	 Random stitch

Path: <Random stitch>
Description:
Click on the icon of random stitch embroidery to create photo stitch images of random 
stitch embroidery.
Suggestions for using photos:
	- The theme is clear and occupies a large proportion of the whole picture.
	- The image should not be gray and dark. The brightness, contrast, and saturation can be 
adjusted in due course.

	- The photo pixel is recommended not to be lower than 500 pixels.
1. Photo adjustment 
Description:
After the image is selected, you can choose the style mode you want to produce, and 
make image adjustments for the image.
Step:

1.	 Click <Random Stitch Embroidery Module>  and select the image to be made into 

random stitch embroidery.
If you want to re-select the image, you can use the <Change Image File> function to re-
select the image.

Open image

Photo Stitch
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Original image Adjusted image
preview area

1 6
5

8
7
10

11

2
4

Image adjustment

Function item description:

3.	 Click the <Next> button to enter the next step execution screen.

2.	 Select image mode, there are three modes (color/grayscale/monochrome) to choose 
from.
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93

Image adjustment

1. Color:
Generate color random stitch photo in stitch 
image.
2. Grayscale:
Generate grayscale random stitch photo in 
stitch image.
3. Monochrome:
Generate monochrome random stitch photo 
in stitch image.
4. Change picture file:
Change photo.
5. Contrast adjustment:
You can adjust the contrast of the photo to 
make the difference between light and dark 
more obvious.
6. Sharpness adjustment:
It can improve the sharpness of the photo, 
increase the contrast of the edge of the 
photo, and make the photo clearer.
7. Brightness adjustment:
You can adjust the lightness and darkness 
of the photo.

8. Saturation Adjustment:
You can adjust the vividness of the color 
of the photo.
9. Black and white ratio adjustment:
Adjust the black and white ratio of 
monochrome photos.
10. Next step:
Press the next step button to enter the 
next step execution screen.
11. Close:
Press the close button to cancel the 
image output of random stitch embroidery 
and return to the main window.
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2. Image shape setting
Description:
Image shape setting.
Step:
1.	 Use the function buttons to edit the shape of the image, and use the mouse to click on 

the Bezier node to select the image position to be generated.
Image shape setting

2.	 Click the <Next> button to enter the next step execution screen.
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Function item description:

1

9

10

13

11
12

8
7

2 3 4 5 6

Image shape setting

Image preview area

1. Rectangle:
The shape of the cropped image is a rectangle.
2. Pentagon:
The shape of the cropped image is a pentagon.
3. Rhombus:
The shape of the cropped image is rhombus.
4. Hexagon:
The shape of the cropped image is hexagon.
5. Oval:
The shape of the cropped image is oval.
6. Polygon:
The shape of the cropped image is in any shape. Use the mouse to click on the bezier 
curve, you can directly add nodes on the line, directly click the control point, can be used 
with the delete button to delete and move nodes.
7. Move:
Move the position of the preview workspace. After clicking this function and moving the 
mouse to the workspace, the mouse icon will change to a moving icon , at this time, 
click and hold the screen to drag the screen directly. Click <Move> again, the mouse will 
cancel the move function, and the mouse will return to the selection tool .。
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3. Image size setting
Description:
Image size setting.
Step:
1.	 Use the function bar to directly input the image file size, or use the <Zoom to 

Embroidery Frame> function to adjust the size.
The size adjustment range is 30.0mm~300.0mm, if the size is not within this range, the 
next step cannot be performed.

2.	 Click the <Next> button to enter the next step execution screen.

8. Return to original ratio:
Click this function, and the display ratio of the work area on the screen will be restored to 
1:1.
9. Viewing ratio:
According to the selected ratio, adjust the display ratio of the work area on the screen, and 
the maximum can be zoomed to 200%.
10. Reset:
Return to the initial screen of graphic cutting.
11. Previous step:
Press the previous step button to return to the previous step execution screen.
12. Next step:
Press the next step button to enter the next step execution screen.
13.Close:
Press the close button to cancel the image output of random stitch embroidery and return 
to the main window.
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1. Zoom to the embroidery frame:
The size of the photo will fill the page proportionally according to the currently set frame 
size.
2. Change the size of the embroidery frame:
Click to change the size of the embroidery frame to change the current size of the frame.
3. Lock ratio:
Lock or not lock the photo size ratio.
4. Size display and adjustment:
Directly enter the size at the width/height, and the size can be entered up to the first 
decimal place.
5. Reset:
Return to the original size of the image.
6. Previous step:
Press the previous step button to return to the previous step execution screen.
7. Next step:
Press the next step button to enter the next step execution screen.
8. Close:
Press the close button to cancel the image output of random stitch embroidery and return 
to the main window.

Function item description:
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4. Set parameters / Color change
Description:
Set relevant parameters for the output  random stitch embroidery.
Step:
1.	 Click <Embroidery Thread Brand List> to select the embroidery thread color brand.
2.	 Enter the number of embroidery thread colors, 10 colors are preset, and the adjustable 

range is 4~50 colors. After thread brand and color are selected, the color can be 
adjusted independently and the reserved color function can be set. When the color is 
set as reserved color, please adjust again the embroidery thread brand, thread color, 
brightness and contrast, the reserved color will remain unchanged.

3.	 The image can be set according to the effect such as density, fineness, stitch distance 
and whether to use outer frame zigzag hemming and other functions.

4.	 Click <Update Preview>, the stitch preview will display the parameter setting results.
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Set Parameters / Color Change
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5.	 Click the  button to complete the random stitch embroidery image and return to 

the main window.
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Set Parameters / Color Change

Stitch preview 
area

Function item description:

1. Thread color label list:
Press the thread color label setting to change the thread color label. When the reserved 
color function is activated, the color remains unchanged.
2. Number of colors:
Set the number of colors in the photo, the default is 10 colors, and the setting range is 4-50 
colors. The actual output color number will be expressed according to the calculation result 
of the image file.
The number of colors can be directly input by the keys, or the up and down keys can be 
used to increase or decrease the color.
When the reserved color function is enabled, the minimum number of colors is the number 
of reserved colors.
3. Color information:
Display the color, brand, color description and color number, and modify the thread color 
brand and thread color for a single color.
 Place the mouse on the color column (at this time the color column is grayed out), use the 
left mouse button to quickly click twice, and the window for modifying the brand color will 
appear. Click on the thread color to modify the thread color brand/color. When the retain 
color function is activated, the thread color modification function cannot be entered.
4. Reserved color:
Press the function of retaining thread color, the icon will be represented by blue-green
, and the current color can be retained. To cancel the reserve function, click the icon 
again, and the icon will be represented by gray . The setting can be canceled. When the 
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function of retaining color is activated, the color changes brand or color number, the color 
remains unchanged.
5. Brightness adjustment:
Brightness adjustment can adjust the lightness and darkness of stitches. When the 
reserved color function is activated, the color remains unchanged.
6. Contrast adjustment:
Contrast adjustment can adjust the contrast of stitches, making the difference between 
light and dark more obvious. When the reserved color function is activated, the color 
remains unchanged.
7. Density adjustment:
Set image density, preset 3. The larger the adjustment number, the  thinner the stitch 
density. The lower the adjustment number, the denser the stitch density.
8. Fineness adjustment:
Set the fineness of the image effect, preset 2. The larger the adjustment number, the finer 
the stitching effect. The smaller the adjustment number is, the less fine the stitching effect 
will be.
9. Outer frame zigzag hemming:
Set whether to add zigzag to the outer frame of the image, default/uncheck, when checked, 
default 2.5mm.
10. Stitch distance:
Set the stitch distance of the image, preset 2.5mm.
11. Update preview:
Press the <Update preview> button to regenerate a new stitch icon according to the 
adjusted parameters.
12. Previous step:
Press the previous step button to return to the previous step execution screen.
13.Completion:
Press the Finish button to produce random stitches and return to the main window.
14. Close:
Press the close button to cancel the image output of random stitch embroidery and return 
to the main window.
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	● Photo Stitch-Sub module 2

	 Overlap satin stitch

Path: <Overlap satin stitch>
Description:
Click on the icon of Overlap satin stitch embroidery to create photo stitch images of overlap 
satin embroidery.
Suggestions for using photos:
	- The theme is clear and occupies a large proportion of the whole picture.
	- The image should not be gray and dark. The brightness, contrast, and saturation can be 
adjusted in due course.

	- The photo pixel is recommended not to be lower than 500 pixels.
1. Image adjustment
Description:
After the image is selected, you can choose the style mode you want to produce, and 
make image adjustments for the image.
Step:

1.	 Click <Overlap satin stitch embroidery module>  and select the image to be made 

into Overlap satin stitch embroidery.
If you want to re-select the image, you can use the <Change Image File> function to re-
select the image.

Open image
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2.	 Select image mode, there are three modes (color/grayscale/monochrome) to choose 
from.

Original image Adjusted image
preview area

1 6
5

8
7
10

11

2
4

Image adjustment

Function item description:

3.	 Click the <Next> button to enter the next step execution screen.
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1. Color:
Generate coloroverlap satin stitch photo in 
stitch image.
2. Grayscale:
Generate grayscale Overlap satin stitch 
photo in stitch image.
3. Monochrome:
Generate monochrome Overlap satin stitch 
photo in stitch image.
4. Change picture file:
Change photo.
5. Contrast adjustment:
You can adjust the contrast of the photo to 
make the difference between light and dark 
more obvious.
6. Sharpness adjustment:
It can improve the sharpness of the photo, 
increase the contrast of the edge of the 
photo, and make the photo clearer.
7. Brightness Adjustment:
You can adjust the lightness and darkness 
of the photo.

8. Saturation Adjustment:
You can adjust the vividness of the color 
of the photo.
9. Black and white ratio adjustment:
Adjust the black and white ratio of 
monochrome photos.
10. Next step:
Press the next step button to enter the 
next step execution screen.
11. Close:
Press the close button to cancel the image 
output of Overlap satin stitch embroidery 
and return to the main window.

93

Image adjustment



115

2. Image shape setting
Description:
Image shape setting.
Step:
1.	 Use the function buttons to edit the shape of the image, and use the mouse to click on 

the Bezier node to select the image position to be generated.
Image shape setting

2.	 Click the <Next> button to enter the next step execution screen.
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Function item description:
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Image shape setting

Image preview area

1. Rectangle:
The shape of the cropped image is a rectangle.
2. Pentagon:
The shape of the cropped image is a pentagon.
3. Rhombus:
The shape of the cropped image is rhombus.
4. Hexagon:
The shape of the cropped image is hexagon.
5. Oval:
The shape of the cropped image is oval.
6. Polygon:
The shape of the cropped image is in any shape. Use the mouse to click on the Bezier 
curve, you can directly add nodes on the line, directly click the control point, can be used 
with the delete button to delete and move nodes.
7. Move:
Move the position of the preview workspace. After clicking this function and moving the 
mouse to the workspace, the mouse icon will change to a moving icon , At this time, 
click and hold the screen to drag the screen directly. Click <Move> again, the mouse will 
cancel the move function, and the mouse will return to the selection tool .
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8. Return to original ratio:
Click this function, and the display ratio of the work area on the screen will be restored to 
1:1.
9. Viewing ratio:
According to the selected ratio, adjust the display ratio of the work area on the screen, and 
the maximum can be zoomed to 200%.
10. Reset:
Return to the initial screen of graphic cutting.
11. Previous step:
Press the previous step button to return to the previous step execution screen.
12. Next step:
Press the next step button to enter the next step execution screen.
13. Close:
Press the close button to cancel the image output of overlap satin stitch embroidery and 
return to the main window.

3. Image size setting
Description:
Image size setting.
Step:
1.	 Use the function bar to directly input the image file size, or use the <Zoom to 

Embroidery Frame> function to adjust the size.
The size adjustment range is 30.0mm~300.0mm, if the size is not within this range, the 
next step cannot be performed.

2.	 Click the <Next> button to enter the next step execution screen.
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1. Zoom to the embroidery frame:
The size of the photo will fill the page proportionally according to the currently set frame 
size.
2. Change the size of the embroidery frame:
Click to change the size of the embroidery frame to change the current size of the frame.
3. Lock Ratio:
Lock or not lock the photo size ratio.
4. Size display and adjustment:
Directly enter the size at the width/height, and the size can be entered up to the first 
decimal place.
5. Reset:
Return to the original size of the image.
6. Previous step:
Press the previous step button to return to the previous step execution screen.
7. Next step:
Press the next step button to enter the next step execution screen.
8. Close:
Press the close button to cancel the image output of overlap satin stitch embroidery and 
return to the main window.

Function item description:
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4. Set parameters / Color change
Description:
Set relevant parameters for the output overlap satin stitch embroidery.
Step:
1.	 Click <Embroidery Thread Brand List> to select the embroidery thread color brand.
2.	 There are 4 preset colors , and can not be adjusted.The color can be adjusted 

independently and the reserved color function can be set. When the color is set 
as reserved color, please adjust again the embroidery thread brand, thread color, 
brightness and contrast, the reserved color will remain unchanged.

3.	 The image can be based on the maximum density, line height, angle and whether to 
use outer frame zigzag hemming and other functions.

4.	 Click <Update Preview>, the stitch preview will display the parameter setting results.
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Set Parameters / Color Change
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5. Click the  button to complete the random stitch embroidery image and return to 

the main window.
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Function item description:

1. Thread color label list: 
Press the thread color label setting to change the thread color label. When the reserved 
color function is activated, the color remains unchanged.
2. Number of colors:
The number of photo colors is preset to 4 colors and cannot be adjusted.
3. Color information:
Display the color, brand, color description and color number, and modify the thread color 
brand and thread color for a single color.
Place the mouse on the color column (at this time the color column is grayed out), use the 
left mouse button to quickly click twice, and the window for modifying the brand color will 
appear. Click on the thread color to modify the thread color brand/color. When the retain 
color function is activated, the thread color modification function cannot be entered.
4. Reserved color:
Press the function of retaining thread color, the icon will be represented by blue-green
, and the current color can be retained. To cancel the reserve function, click the icon 
again, and the icon will be represented by gray . The setting can be canceled. When the 
function of retaining color is activated, the color changes brand or color number, the color 
remains unchanged.
5. Brightness adjustment:
Brightness adjustment can adjust the lightness and darkness of stitches. When the 

Image 
preview area
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reserved color function is activated, the color remains unchanged.
6. Contrast adjustment:
Contrast adjustment can adjust the contrast of stitches, making the difference between 
light and dark more obvious. When the reserved color function is activated, the color 
remains unchanged.
7. Maximum density:
Set the maximum linear density, preset 4. The larger the adjustment number, the denser 
the line wrinkle density. The lower the adjustment number, the thinner the line wrinkle 
density.
8. Line height:
Set the line spacing, default 2. The larger the adjustment number, the larger the line 
spacing. The smaller the adjustment number, the smaller the line spacing.
9. Outer frame zigzag hemming:
Set whether to add zigzag to the outer frame of the image, default/uncheck, when checked, 
default 2.5mm.
10. Angle:
Set stitch angle, default 0. The adjustment range is 0~179. You can enter a value or press 
the up and down arrows on the right to adjust, or press and hold the graphic icon to rotate 
and adjust.
11. Update preview:
Press the <Update preview> button to regenerate a new stitch icon according to the 
adjusted parameters.
12. Previous step:
Press the previous step button to return to the previous step execution screen.
13. Completion:
Press the Finish button to produce image stitches of overlap satin stitch embroidery and 
return to the main window.
14. Close:
Press the close button to cancel the image output of overlap satin stitch embroidery and 
return to the main window.
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	● Photo Stitch-Sub module 3

	 Cross stitch

Path: <Cross stitch>
Description:
Click on the icon of Cross stitch embroidery to create photo stitch images of Crossed stitch 
embroidery.
Suggestions for using photos:
	- The theme is clear and occupies a large proportion of the whole picture.
	- The image should not be gray and dark. The brightness, contrast, and saturation can be 
adjusted in due course.

	- The photo pixel is recommended not to be lower than 500 pixels.
1. Image adjustment
Description:
After the image is selected, you can choose the style mode you want to produce, and 
make image adjustments for the image.
Step:

1.	 Click <Cross stitch embroidery module>  and select the image to be made into 

Cross stitch embroidery.
If you want to re-select the image, you can use the <Change Image File> function to re-
select the image.

Open image
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Original image Adjusted image
preview area

1 6
5

8
7
10

11

2
4

Image adjustment

Function item description:

3.	 Click the <Next> button to enter the next step execution screen.

2.	 Select image mode, there are three modes (color/grayscale/monochrome) to choose 
from.
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93

Image adjustment

1. Color:
Generate color Cross stitch photo in stitch 
image.
2. Grayscale:
Generate grayscale Cross stitch photo in 
stitch image.
3. Monochrome:
Generate monochrome Cross stitch photo in 
stitch image.
4. Change picture file:
Change photo.
5. Contrast adjustment:
You can adjust the contrast of the photo to 
make the difference between light and dark 
more obvious.
6. Sharpness adjustment:
It can improve the sharpness of the photo, 
increase the contrast of the edge of the 
photo, and make the photo clearer.
7. Brightness Adjustment:
You can adjust the lightness and darkness 
of the photo.

8. Saturation Adjustment:
You can adjust the vividness of the color 
of the photo.
9. Black and white ratio adjustment:
Adjust the black and white ratio of 
monochrome photos.
10. Next step:
Press the next step button to enter the 
next step execution screen.
11. Close:
Press the close button to cancel the 
image output of Cross stitch embroidery 
and return to the main window.
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2. Image shape setting
Description:
Image shape setting.
Step:
1.	 Use the function buttons to edit the shape of the image, and use the mouse to click on 

the Bezier node to select the image position to be generated.
Image shape setting

2.	 Click the <Next> button to enter the next step execution screen.
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Function item description:
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Image shape setting

Image preview area

1. Rectangle:
The shape of the cropped image is a rectangle.
2. Pentagon:
The shape of the cropped image is a pentagon.
3. Rhombus:
The shape of the cropped image is rhombus.
4. Hexagon:
The shape of the cropped image is hexagon.
5. Oval:
The shape of the cropped image is oval.
6. Polygon:
The shape of the cropped image is in any shape. Use the mouse to click on the Bezier 
curve, you can directly add nodes on the line, directly click the control point, can be used 
with the delete button to delete and move nodes.
7. Move:
Move the position of the preview workspace. After clicking this function and moving the 
mouse to the workspace, the mouse icon will change to a moving icon ,  at this time, 
click and hold the screen to drag the screen directly. Click <Move> again, the mouse will 
cancel the move function, and the mouse will return to the selection tool .
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8. Return to original ratio:
Click this function, and the display ratio of the work area on the screen will be restored to 
1:1.
9. Viewing ratio:
According to the selected ratio, adjust the display ratio of the work area on the screen, and 
the maximum can be zoomed to 200%.
10. Reset:
Return to the initial screen of graphic cutting.
11. Previous step:
Press the previous step button to return to the previous step execution screen.
12. Next step:
Press the next step button to enter the next step execution screen.
13. Close:
Press the close button to cancel the image output of Cross stitch embroidery and return to 
the main window.

3. Image size setting
Description:
Image size setting.
Step:
1.	 Use the function bar to directly input the image file size, or use the <Zoom to 

Embroidery Frame> function to adjust the size.
The size adjustment range is 30.0mm~300.0mm, if the size is not within this range, the 
next step cannot be performed.

2.	 Click the <Next> button to enter the next step execution screen.
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1. Zoom to the embroidery frame:
The size of the photo will fill the page proportionally according to the currently set frame 
size.
2. Change the size of the embroidery frame:
Click to change the size of the embroidery frame to change the current size of the frame.
3. Lock Ratio:
Lock or not lock the photo size ratio.
4. Size display and adjustment:
Directly enter the size at the width/height, and the size can be entered up to the first 
decimal place.
5. Reset:
Return to the original size of the image.
6. Previous step:
Press the previous step button to return to the previous step execution screen.
7. Next step:
Press the next step button to enter the next step execution screen.
8. Close:
Press the close button to cancel the image output of Cross stitch embroidery and return to 
the main window.

Function item description:
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4. Set parameters / Color change
Description:
Set relevant parameters for the output Cross stitch embroidery.
Step:
1.	 Click <Embroidery Thread Brand List> to select the embroidery thread color brand.
2.	 Enter the number of embroidery thread colors, 8 colors are preset, the adjustable 

range is 4~50 colors. After thread brand and color are selected, the color can be 
adjusted independently and the reserved color function can be set. When the color is 
set as reserved color, please adjust again the embroidery thread brand, thread color, 
brightness and contrast, the reserved color will remain unchanged.

3.	 The image can be set according to the effect such as size, number of times, whether to 
use outer frame zigzag hemming , whether to change the cross stitch to a unified grid, 
etc.

4.	 Click <Update Preview>, the stitch preview will display the parameter setting results.
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Set Parameters / Color Change
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5.	 Click the  button to complete the random stitch embroidery image and return to 

the main window.
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Function item description:
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Stitch preview 
area

1. Thread color label list:
Press the thread color label setting to change the thread color label. When the reserved 
color function is activated, the color remains unchanged.
2. Number of colors:
The number of photo colors is preset to 8 colors, the adjustable range is 4~50 colors. The 
actual output color number will be expressed according to the calculation result of the 
image file. The number of colors can be directly input by the keys, or the up and down keys 
can be used to increase or decrease the color.
When the reserved color function is enabled, the minimum number of colors is the number 
of reserved colors.
3. Color information:
Display the color, brand, color description and color number, and modify the thread color 
brand and thread color for a single color.
Place the mouse on the color column (at this time the color column is grayed out), use the 
left mouse button to quickly click twice, and the window for modifying the brand color will 
appear. Click on the thread color to modify the thread color brand/color. When the retain 
color function is activated, the thread color modification function cannot be entered.
4. Reserved color:
Press the function of retaining thread color, the icon will be represented by blue-green
, and the current color can be retained. To cancel the reserve function, click the icon 
again, and the icon will be represented by gray . The setting can be canceled. When the 
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function of retaining color is activated, the color changes brand or color number, the color 
remains unchanged.
5. Brightness adjustment:
Brightness adjustment can adjust the lightness and darkness of stitches. When the 
reserved color function is activated, the color remains unchanged.
6. Contrast adjustment:
Contrast adjustment can adjust the contrast of stitches, making the difference between 
light and dark more obvious. When the reserved color function is activated, the color 
remains unchanged.
7. Cross stitch size:
Set the cross stitch size, preset 2.0, adjustable range 1.5~5.0 mm, jump value 0.1.
8. Wiring times:
Set image wiring times, preset/2 times, adjustable range 2, 4, 6 times.
9. Outer frame zigzag hemming:
Set whether to add zigzag to the outer frame of the image, default/uncheck, when checked, 
default 2.5mm.
10. Use all cross stitch style:
Change the image style, preset/size grid, and adjust it to a unified grid.
11. Update preview:
Press the <Update preview> button to regenerate a new stitch icon according to the 
adjusted parameters.
12. Previous step:
Press the previous step button to return to the previous step execution screen.
13. Completion:
Press the Finish button to produce image stitches of Cross stitch embroidery and return to 
the main window.
14. Close:
Press the close button to cancel the image output of Cross stitch embroidery and return to 
the main window.
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System Requirements

	- PC with intel processor or equivalent (2GHz or higher)
	- Microsoft Windows 7, 8, 10
	- 4 GB RAM 
	- 200 MB hard disk space for program installation
	- Screen resolution 1024x768, 16 million colors
	- Keyboard, Mouse

	● Microsoft Windows

	● Apple macOS
	- OS X 10.13 or later
	- 4 GB RAM 
	- 200 MB hard disk space for program installation
	- Screen resolution 1024x768, 16 million colors
	- Keyboard, Mouse



Embroidery Pattern Chart
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Embroidery Pattern Chart

	 Floral & Plant

01001

01006

01003

01008

01002

01007

01004

01009

01005

01010

	 Animal

02001

02006

02003

02008

02002

02007

02004

02009

02005

02010
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	 Frame

05001

05006

05003

05008

05002

05007

05004

05009

05005

	 Totem

06001

06006

06003

06008

06002

06007

06004

06009

06005

06010

06011 06012
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	 Christmas

09001 0900309002 09004

	 Sport

09001

09006

09003

09008

09002

09007

09004 09005

	 Halloween

09001 0900309002
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	 Houseware

24001 2400324002 24004

	 Scenery

22001

22006

22003

22008

22002

22007

22004

22009

22005

22010
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